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BAB II 

TINJAUAN PUSTAKA 

 

2.1 Mikrokontroler 

Mikrokontroler merupakan sebuah prosesor yang digunakan untuk 

kepentingan kontrol. Meskipun mempunyai bentuk yang jauh lebih kecil dari 

suatu komputer pribadi dan komputer mainframe, mikrokontroler dibangun dari 

elemen-elemen dasar yang sama. Seperti umumnya komputer, mikrokontroler 

adalah alat yang mengerjakan intruksi-intruksi yang diberikan kepadanya. 

Artinya, bagian terpenting dan utama dari suatu sistem terkomputerisasi adalah 

program itu sendiri yang dibuat oleh seorang programmer. Program ini 

menginstruksikan komputer untuk melakukan tugas yang lebih kompleks yang di 

inginkan oleh programmer. Menurut Sumardi (2013:1). 

Beberapa fitur yang umumnya ada di dalam mikrokontroler adalah sebagai 

berikut: 

1. ROM (Read Only Memory) 

ROM berfungsi untuk tempat penyimpanan variabel. Memori ini bersifat 

volatile yang berarti akan kehilangan semua datanya jika tidak mendapat 

catu daya. 

2. RAM (Random Access Memory) 

RAM digunakan oleh mikrokontroler untuk tempat penyimpanan program 

yang akan diberikan oleh user. 

3. Register 

Register merupakan tempat penyimpanan nilai-nilai yang akan digunakan 

dalam proses yang telah disediakan oleh mikrokontroler. 

4. Special Function Register 

Special Function Register merupakan register khusus yang berfungsi 

untuk mengatur jalannya mikrokontroler. Register ini terletak pada RAM. 

5. Input dan Output Pin 



5 
 

  

Pin input adalah bagian yang berfungsi sebagai penerima signal dari luar, 

pin ini dapat dihubungkan ke berbagai media inputan seperti keypad, 

sensor, dan sebagainya. Pin output adalah bagian yang berfungsi untuk 

mengeluarkan signal dari hasil proses algoritma mikrokontroler. 

6. Interupt  

Interupt adalah bagian mikrokontroler yang berfungsi sebagai bagian yang 

dapat melakukan interupsi, sehingga ketika program utama sedang 

berjalan, programutama tersebut dapat di interupsi dan menjalankan 

program interupsi terlebih dahulu. 

Beberapa interupt pada umumnya adalah sebagai berikut: 

1. Interupt eksternal 

Interupt akan terjadi bila ada inputan dari pin interupt. 

2. Interupt timer 

Interupt akan terjadi bila waktu tertentu telah tercapai. 

3. Interupt serial 

Interupt yang terjadi ketika ada penerimaan data dari komunikasi 

serial. 

Rata-rata mikrokontroler memiliki instruksi manipulasi bit, akses ke I/O 

secara langsung dan mudah, dan proses interupt yang cepat dan efisien. Dengan 

kata lain mikrokontroler adalah ”Solusi satu Chip” yang secara drastis 

mengurangi jumlah komponen dan biaya desain (harga relatif murah) 

(bem.ilkom.unsri.ac.id:2011). 

 

2.2 Fitur AVR ATMega328 

ATMega328 adalah mikrokontroler keluaran dari atmel yang mempunyai 

arsitektur RISC (Reduce Instruction Set Computer) yang dimana setiap proses 

eksekusi data lebih cepat dari pada arsitektur CISC (Completed Instruction Set 

Computer). 
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Mikrokontroler ini memiliki beberapa fitur antara lain: 

1. 130 macam instruksi yang hampir semuanya dieksekusi dalam satu siklus 

clock. 

2. 32 x 8-bit register serba guna. 

3. Kecepatan mencapai 16 MPS dengan clock 16 MHz. 

4. 32 KB Flash memory dan pada arduino memiliki bootloader yang 

menggunakan 2KB dari flash memori sebagai bootloader. Memiliki 

EEPROM (Electrically Erasable Programmable Read Only Memory) 

sebesar 1 KB sebagai tempat penyimpanan data semi permanen karena 

EEPROM tetap dapat menyimpan data meskipun catu daya dimatikan. 

5. Memiliki pin I/O digital sebanyak 14 pin, 6 diantaranya PWM (Pulse 

Width Modulation) output. 

6. Master / Slave SPI Serial interface. 

Mikrokontroler ATMega328 memiliki arsitektur Harvard, yaitu 

memisahkan memori untuk kode program dan memori untuk data sehingga dapat 

memaksimalkan kerja dan parallelism. Intruksi-intruksi dalam memori program 

dieksekusi dalam satu alur tunggal, dimana pada saat satu instruksi dikerjakan 

instruksi berikutnya sudah diambil dari memori program. Konsep inilah yang 

memungkinkan instruksi-instruksi dapat dieksekusi dalam satu siklus clock. 

32 x 8-bit register serbaguna digunakan untuk mendukung operasi pada 

ALU (Aritmatika Logic Unit) yang dapat dilakukan dalam satu siklus. 6 dari 

register serbaguna ini dapat digunakan sebagai 3 buah register pointer 16-bit pada 

mode pengalamatan tak langsung untuk mengambil data pada ruang memori data. 

Ketiga register pointer 16-bit ini disebut dengan register X (gabungan R26 dan 

R27), register Y (gabungan R28 dan R29), dan register Z (gabungan R30 dan 

R31). 

Hampir semua instruksi AVR memiliki format 16-bit. Setiap alamat 

memori program terdiri dari instruksi 16-bit atau 32-bit. Selain register serbaguna 

diatas, terdapat register lain yang terpetakan dengan teknik memory mapped I/O 

selebar 64 byte. Beberapa register ini digunakan untuk fungsi khusus antara lain 

sebagai register control Timer / Counter, Interupsi, ADC, USART, SPI, 
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EEPROM, dan fungsi I/O lainnya. Register-register ini menempati memori pada 

alamat 0x20h – 0xFh. (repository.usu.ac.id:2012). 

 

Gambar 2.1 Architecture ATMega328 

(Sumber: ejournal.unsrat.ac.id) 

 

2.3 Konfigurasi PIN ATMega328 

 

Gambar 2.2 Konfigurasi PIN ATMega328 

(Sumber: Syahid, 2012 : 34) 
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Tabel 2.1 Konfigurasi Port B 

 

Tabel 2.2 Konfigurasi Port C 
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Tabel 2.3 Konfigurasi Port D 

 

 

2.4 Komunikasi Serial Mikrokontroler 

 Komunikasi serial adalah komunikasi yang pengiriman data per-bit secara 

berurutan dan bergantian. Komunikasi ini mempunyai kelebihan yaitu hanya 

membutuhkan satu jalur dan kabel yang sedikit dibandingkan dengan komunikasi 

paralel. Pada prinsipnya komunikasi serial merupakan komunikasi dimana 

pengiriman data dilakukan per-bit sehingga lebih lambat dibandingkan 

komunikasi paralel, atau dengan kata lain komunikasi serial merupakan salah satu 

metode komunikasi data dimana hanya satu bit data yang dikirimkan melalui 

seuntai kabel pada satu waktu tertentu. Pada dasarnya komunikasi serial adalah 

kasus khusus komunikasi paralel dengan nilai n = 1, atau dengan kata lain adalah 

suatu bentuk komunikasi paralel dengan jumlah kabel hanya satu dan hanya 

mengirimkan satu bit data secara simultan. Hal ini dapat disandingkan dengan 

komunikasi paralel yang sesungguhnya dimana n-bit data dikirimkan bersamaan, 

dengan nilai umumnya 8 ≤ n ≤ 128. 
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 Komunikasi serial ada dua macam, asynchronous serial dan synchronous 

serial. Synchronous serial adalah komunikasi dimana hanya ada satu pihak 

(pengirim atau penerima) yang menghasilkan clock dan mengirimkan clock 

tersebut bersama-sama dengan data. Contoh penggunaan synchronous serial 

terdapat pada transmisi data keyboard. Asynchronous serial adalah komunikasi 

dimana kedua pihak (pengirim dan penerima) masing-masing menghasilkan clock 

namun hanya data yang ditransmisikan, tanpa clock. Agar data yang dikirimkan 

sama dengan data yang diterima, maka kedua frekuensi clock harus sama dan 

harus terdapat sinkronisasi. Setelah adanya sinkronisasi, pengirim akan 

mengirimkan datanya sesuai dengan frekuensi clock penerima. Contoh 

penggunaan asynchronous serial adalah pada Universal Asynchronous Receiver 

Transmitter (UART) yang digunakan pada serial port (COM) komputer. 

 Antarmuka kanal serial lebih kompleks/sulit dibandingkan dengan 

antarmuka melalui kanal paralel, hal ini disebabkan karena : 

1. Dari segi perangkat keras : adanya proses konversi data paralel menjadi 

serial atau sebaliknya menggunakan piranti tambahan yang disebut UART 

(Universal Asynchronous Receiver Transmitter). 

2. Dari segi perangkat lunak : lebih banyak resgister yang digunakan atau 

terlibat. 

Namun disisi lain antarmuka kanal serial menawarkan beberapa kelebihan 

dibandingkan secara paralel, antara lain : 

1. Kabel untuk komunikasi serial bisa lebih panjang dibandingkan dengan 

paralel; data-data dalam komunikasi serial dikirimkan untuk logika ’1’ 

sebagai tegangan -3 s/d -25 volt dan untuk logika ’0’ sebagai tegangan +3 

s/d +25 volt, dengan demikian tegangan dalam komunikasi serial memiliki 

ayunan tegangan maksimum 50 volt. Hal ini menyebabkan gangguan pada 

kabel-kabel panjang lebih mudah diatasi dibandingkan pada paralel. 

2. Jumlah kabel serial lenih sedikit; Anda bisa menghubungkan dua 

perangkat komputer yang berjauhan dengan hanya 3 kabel untuk 

konfigurasi null modem, yaitu TxD (saluran kirim), RxD (saluran terima) 

dan Ground, bayangkan jika digunakan teknik paralel akan terdapat 20 – 
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25 kabel. Namun pada masing-masing komputer dengan komunikasi serial 

harus dibayar ”biaya” antarmuka serial yang agak lebih mahal. 

3. Banyaknya piranti saat ini (palmtop, organizer, hand-phone dan lain-lain) 

menggunkan teknologi inframerah untuk komunikasi data, dalam hal ini 

peringirman datanya dilakukan secara serial. irDA-1 (spesifikasi 

inframerah pertama) mampu mengirimkan data dengan laju 115,2 kbps 

dan konsep komunikasi serial dibantu dengan piranti UART, hanya 

panjang pulsa berkurang menjadi 3/16 dari standar RS-232 untuk 

menghemat daya. 

4. Untuk teknologi embedde system, banyak mikrokontroler yang dilengkapi 

dengan komunikasi serial (baik seri RISC maupun CISC) atau Serial 

Communication Interface (SCI); dengan adanya SCI yang terpadu pada IC 

mikrokontroler akan mengurangi jumlah pin keluaran, sehingga hanya 

dibutuhkan 2 pin utama TxD dan RxD (diluar acuan ground) 

(arifzakariya:2012). 

 

2.5 Arduino Uno  

Arduino Uno adalah arduino board yang menggunakan mikrokontroler 

ATmega328. Arduino Uno memiliki 14 pin digital (6 pin dapat digunakan sebagai 

output PWM), 6 input analog, sebuah 16 MHz osilator kristal, sebuah koneksi 

USB, sebuah konektor sumber tegangan, sebuah header ICSP, dan sebuah tombol 

reset. Arduino Uno memuat segala hal yang dibutuhkan untuk mendukung sebuah 

mikrokontroler. Hanya dengan menhubungkannya ke sebuah komputer melalui 

USB atau memberikan tegangan DC dari baterai atau adaptor AC ke DC sudah 

dapat membuanya bekerja. Arduino Uno menggunakan ATmega16U2 yang 

diprogram sebagai USB-to-serial converter untuk komunikasi serial ke computer 

melalui port USB. Tampak atas dari arduino uno dapat dilihat pada Gambar 2.1.  
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Adapun data teknis board Arduino UNO R3 adalah sebagai berikut:  

1. Mikrokontroler : ATmega328  

2. Tegangan Operasi : 5V 

3. Tegangan Input (recommended) : 7 - 12 V  

4. Tegangan Input (limit) : 6-20 V  

5. Pin digital I/O : 14 (6 diantaranya pin PWM)  

6. Pin Analog input : 6  

7. Arus DC per pin I/O : 40 mA  

8. Arus DC untuk pin 3.3 V : 150 mA  

9. Flash Memory : 32 KB dengan 0.5 KB digunakan untuk bootloader  

10. SRAM : 2 KB  

11. EEPROM : 1 KB 

12. Kecepatan Pewaktuan : 16 Mhz 

 

Gambar 2.3 Arduino Uno 

(Sumber: Repository.usu.ac.id) 

 

2.5.1 Pin Masukan dan Keluaran Arduino Uno 

Masing-masing dari 14 pin digital arduino uno dapat digunakan sebagai 

masukan atau keluaran menggunakan fungsi pinMode(), digitalWrite() dan 

digitalRead(). Setiap pin beroperasi pada tegangan 5 volt. Setiap pin mampu 

menerima atau menghasilkan arus maksimum sebesar 40 mA dan memiliki 10 

resistor pull-up internal (diputus secara default) sebesar 20-30 KOhm. 
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Sebagai tambahan, beberapa pin masukan digital memiliki kegunaan 

khusus yaitu: 

1. Komunikasi serial: pin 0 (RX) dan pin 1 (TX), digunakan untuk menerima 

(RX) dan mengirim (TX) data secara serial. 

2. External Interrupt: pin 2 dan pin 3, pin ini dapat dikonfigurasi untuk 

memicu sebuah interrupt pada nilai rendah, sisi naik atau turun, atau pada 

saat terjadi perubahan nilai. 

3. Pulse-width modulation (PWM): pin 3,5,6,9,10 dan 11, menyediakan 

keluaran PWM 8-bit dengan menggunakan fungsi analogWrite(). 

4. Serial Peripheral Interface (SPI): pin 10 (SS), 11 (MOSI), 12 (MISO) dan 

13 (SCK), pin ini mendukung komunikasi SPI dengan menggunakan SPI 

library. 

5. LED: pin 13, terdapat built-in LED yang terhubung ke pin digital 13. 

Ketika pin bernilai HIGH maka LED menyala, sebaliknya ketika pin 

bernilai LOW maka LED akan padam. 

Arduino uno memiliki 6 masukan analog yang diberi label A0 sampai A5, 

setiap pin menyediakan resolusi sebanyak 10 bit (1024 nilai yang berbeda). Secara 

default pin mengukur nilai tegangan dari ground (0V) hingga 5V, walaupun 

begitu dimungkinkan untuk mengganti nilai batas atas dengan menggunakan pin 

AREF dan fungsi analogReference(). Sebagai tambahan beberapa pin masukan 

analog memiliki fungsi khusus yaitu pin A4 (SDA) dan pin A5 (SCL) yang 

digunakan untuk komunikasi Two Wire Interface (TWI) atau Inter Integrated 

Circuit (I2C) dengan menggunakan Wire library. 

 

2.5.2 Sumber Daya dan Pin Tegangan Arduino Uno 

Arduino uno dapat diberi daya melalui koneksi USB (Universal Serial 

Bus) atau melalui power supply eksternal. Jika arduino uno dihubungkan ke kedua 

sumber daya tersebut secara bersamaan maka arduino uno akan memilih salah 

satu sumber daya secara otomatis untuk digunakan. Power supply eksternal dapat 

berasal dari adaptor AC ke DC atau baterai. Adaptor dapat dihubungkan ke soket 
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power pada arduino uno. Jika menggunakan baterai, ujung kabel yang 

dihubungkan ke baterai dimasukkan kedalam pin GND dan Vin yang berada pada 

konektor POWER. 

Arduino uno dapat beroperasi pada tegangan 6 sampai 20 volt. Jika 

arduino uno diberi tegangan di bawah 7 volt, maka pin 5V akan menyediakan 

tegangan di bawah 5 volt dan arduino uno mungkin bekerja tidak stabil. Jika 

diberikan tegangan melebihi 12 volt, penstabil tegangan kemungkinan akan 

menjadi terlalu panas dan merusak arduino uno. Tegangan rekomendasi yang 

diberikan ke arduino uno berkisar antara 7 sampai 12 volt. 

Pin-pin tegangan pada arduino uno adalah sebagai berikut: 

1. Vin adalah pin untuk mengalirkan sumber tegangan ke arduino uno ketika 

menggunakan sumber daya ekstrenal (Selain dari koneksi USB atau 

sumber daya yang teregulasi lainnya). Sumber tegangan juga dapat 

disediakan melalui pin ini jika sumber daya yang digunakan untuk arduino 

uno dialirkan melalui soket power. 

2. 5V adalah pin yang menyediakan tegangan teregulasi sebesar 5 volt 

berasal dari regulator tegangan pada arduino uno. 

3. 3V3 adalah pin yang menyediakan tegangan teregulasi sebesar 3,3 volt 

berasal dari regulator tegangan pada arduino uno. 

4. GND adalah pin ground. 

 

2.5.3 Peta Memori Arduino Uno 

 Arduino uno adalah arduino board yang menggunakan mikrokontroler 

ATmega328. Maka peta memori arduino uno sama dengan peta memori pada 

mikrokontroler ATmega328. 

 

2.5.3.1 Memori Program 

 ATmega328 memiliki 32K byte On-chip In-System Reprogrammable 

Flash Memory untuk menyimpan program. Memori flash dibagi kedalam dua 

bagian, yaitu bagian program bootloader dan aplikasi. Bootloader adalah program 



15 
 

  

kecil yang bekerja pada saat sistem dimulai yang dapat memasukkan seluruh 

program aplikasi ke dalam memori prosesor. 

 

Gambar 2.4 Peta Memori Program ATMega328 

(Sumber: Repository.usu.ac.id) 

 

2.5.3.2 Memori Data 

 Memori data ATMega328 terbagi menjadi 4 bagian, yaitu 32 lokasi untuk 

register umum, 64 lokasi untuk register I/O, 160 lokasi untuk register I/O 

tambahan dan sisanya 2048 lokasi untuk data SRAM internal. Register umum 

menempati alamat data terbawah, yaitu 0x0000 sampai 0x001F. Register I/O 

menempati 64 alamat berikutnya mulai dari 0x0020 hingga 0x005F. Register I/O 

tambahan menempati 160 alamat berikutnya mulai dari 0x0060 hingga 0x00FF. 

Sisa alamat berikutnya mulai dari 0x0100 hingga 0x08FF digunakan untuk SRAM 

internal. Peta memori data dari ATMega 328 dapat dilihat pada Gambar 2.5. 
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Gambar 2.5 Peta Memori Program ATMega328 

(Sumber: Repository.usu.ac.id) 

 

2.5.3.3 Memori Data EEPROM 

 Arduino uno terdiri dari 1 Kbyte memori data EEPROM. Pada memori 

EEPROM, data dapat ditulis/dibaca kembali dan ketika catu daya dimatikan, data 

terakhir yang ditulis pada memori EEPROM masih tersimpan pada memori ini, 

atau dengan kata lain memori EEPROM bersifat nonvolatile. Alamat EEPROM 

dimulai dari 0x000 hingga 0x3FF. 

 

2.6 Module Wifi ESP8266 

ESP8266 merupakan modul wifi yang berfungsi sebagai perangkat 

tambahan mikrokontroler seperti Arduino agar dapat terhubung langsung dengan 

wifi dan membuat koneksi TCP/IP. 

Modul ini membutuhkan daya sekitar 3.3v dengan memiliki tiga mode 

wifi yaitu Station, Access Point dan Both (Keduanya). Modul ini juga dilengkapi 

dengan prosesor, memori dan GPIO dimana jumlah pin bergantung dengan 

jenis ESP8266 yang kita gunakan. Sehingga modul ini bisa berdiri sendiri tanpa 

http://www.sinauarduino.com/artikel/esp8266/
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menggunakan mikrokontroler apapun karena sudah memiliki perlengkapan 

layaknya mikrokontroler. 

Firmware default yang digunakan oleh perangkat ini menggunakan AT 

Command, selain itu ada beberapa Firmware SDK yang digunakan oleh perangkat 

ini berbasis opensource yang diantaranya adalah sebagai berikut : 

1. NodeMCU dengan menggunakan basic programming lua 

2. MicroPython dengan menggunakan basic programming python 

3. AT Command dengan menggunakan perintah perintah AT command 

Untuk pemrogramannya sendiri kita bisa menggunakan ESPlorer untuk 

Firmware berbasis NodeMCUdan menggunakan putty sebagai terminal control 

untuk AT Command. Selain itu kita bisa memprogram perangkat ini 

menggunakan Arduino IDE. Dengan menambahkan library ESP8266 pada board 

manager kita dapat dengan mudah memprogram dengan basic program arduino. 

 

Gambar 2.6 Module Wifi ESP8266 

(Sumber: electrician.unila.ac.id) 

 

2.7 Lampu Listrik 

Lampu Listrik adalah suatu perangkat yang dapat menghasilkan cahaya 

saat dialiri arus listrik. Arus listrik yang dimaksud ini dapat berasal tenaga listrik 

yang dihasilkan oleh pembangkit listrik terpusat (Centrally Generated Electric 

Power) seperti PLN dan Genset ataupun tenaga listrik yang dihasilkan oleh 

Baterai dan Aki. Lampu Listrik telah menjadi salah satu alat listrik yang paling 

penting bagi kehidupan manusia. Dengan adanya lampu listrik, kita dapat 

http://www.sinauarduino.com/artikel/esp8266/
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melakukan berbagai kegiatan pada malam hari, memperindah Interior maupun 

Eksterior rumah, penerang ruangan yang gelap ataupun sebagai Indikator tanda-

tanda bahaya. Sebelum ditemukan lampu listrik, manusia pada saat itu 

menggunakan lilin, lampu minyak dan api unggun sebagai alat penerang pada 

malam hari. 

 

Gambar 2.7 Lampu Listrik 

(Sumber: http http://www.kelistrikanku.com/) 

 

2.7.1 Jenis-jenis Lampu Listrik 

Pada dasarnya lampu listrik dapat dikategorikan dalam tiga jenis yaitu: 

1. Lampu Pijar (Incandescent lamp) 

Lampu Pijar atau disebut juga Incandescent Lamp adalah jenis lampu 

listrik yang menghasilkan cahaya dengan cara memanaskan Kawat Filamen di 

dalam bola kaca yang diisi dengan gas tertentu seperti  nitrogen, argon, kripton  

atau hidrogen. Kita dapat menemukan Lampu Pijar dalam berbagai pilihan 

Tegangan listrik yaitu Tegangan listrik yang berkisar dari 1,5V hingga 300V. 

Lampu Pijar yang dapat bekerja pada Arus DC maupun Arus AC ini banyak 

digunakan di Lampu Penerang Jalan, Lampu Rumah dan Kantor, Lampu Mobil, 

Lampu Flash dan juga Lampu Dekorasi.  Pada umumnya Lampu Pijar hanya 

dapat bertahan sekitar 1000 jam dan memerlukan Energi listrik yang lebih banyak 

dibandingkan dengan jenis-jenis lampu lainnya. Lampu Halogen juga termasuk 

dalam kategori jenis Lampu Pijar (Incandescent lamp). 

 

http://www.sinauarduino.com/artikel/esp8266/
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2. Lampu Lucutan Gas (Gas-Discharge Lampu) 

Gas-discharge Lamp atau Lampu Lucutan Gas adalah Lampu Listrik yang 

dapat menghasilkan cahaya dengan mengirimkan lucutan Elektris melalui gas 

yang terionisasi. Gas-gas yang digunakan adalah gas mulia seperti argon, neon, 

kripton  dan xenon. Gas-discharge Lamp ini juga memakai bahan-bahan tambahan 

seperti Merkuri, Natrium dan Halida logam. Lampu jenis ini diantaranya adalah 

lampu Fluorescent, Lampu Neon, Lampu Xenon Arc dan Mercury Vapor Lamp. 

Lampu jenis Gas-discharge Lamp yang paling sering kita temukan 

tentunya adalah Lampu Fluorescent yang dipergunakan sebagai lampu penerang 

di rumah maupun kantor. Daya tahan lampu Fluorescent adalah sekitar 10.000 jam 

atau 10 kali lipat lebih tahan daripada Lampu Pijar. Lampu Fluorescent juga lebih 

hemat Energi jika dibandingkan dengan Lampu Pijar. 

3. Lampu LED (Light Emitting Diode) 

Lampu LED adalah Lampu listrik yang menggunakan komponen 

elektronika LED sebagai sumber cahayanya. LED adalah Dioda yang dapat 

memancarkan cahaya monokromatik ketika diberikan Tegangan maju. Lampu 

listrik jenis LED ini memiliki banyak kelebihan seperti lebih hemat energi, lebih 

tahan lama dan tidak mengandung bahan berbahaya (contohnya Merkuri). Namun 

Harga Lampu LED lebih mahal jika dibanding dengan Lampu Fluorescent dan 

Lampu Pijar sehingga penggunaannya masih sangat terbatas. Lampu LED 

memiliki daya tahan hingga 25.000 jam atau 2,5 kali lipat lebih tahan lama dari 

Lampu Fluorescent. Jika dibanding dengan Lampu Pijar, Lampu LED lebih tahan 

lama hingga 25 kali lipat daripada lampu pijar. 

 

2.8 Module Relay 

 Relay adalah sakelar yang dioperasikan secara elektrik. Relay dipakai 

ketika sinyal berdaya rendah digunakan untuk mengontrol sebuah rangkaian 

(isolasi elektrik penuh terjadi antara rangkaian pengontrol dan rangkaian yang 

dikontrol) atau ketika beberapa sirkuit harus dikontrol oleh satu sinyal. Relay pada 

mulanya digunakan pada sirkuit telegram jarak jauh, mengulangi sinyal yang 
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datang dari suatu sirkuit dan mentransmisikan kembali sinyal tersebut ke sirkuit 

yang lain. Relay digunakan secara luas dalam switching telepon dan juga pada 

komputer mula-mula untuk melakukan operasi logis.  

 

Gambar 2.8 Module Relay 4 Kanal 

(Sumber: https://www.sainsmart.com/) 

 

Sebuah relay elektromagnetik sederhana terdiri dari kumparan kawat yang 

membungkus sebuah inti besi, sebuah kuk besi untuk menahan alur flux magnetik, 

sebuah angker (jangkar) besi yang dapat bergerak dan satu set atau lebih kontak. 

Angker tergantung pada kuk dan terhubung secara mekanik dengan kontak yang 

bergerak. Angker ditahan oleh pegas, sehingga ketika relay diputus ada celah 

udara dalam rangkaian magnetik. 

Ketika arus listrik dilewatkan melalui kumparan maka akan dihasilkan 

medan elektromagnetik yang mengaktifkan angker, dan akibat dari bergeraknya 

kontak-yang-bergerak membuat terjadinya penyambungan atau pemutusan 

(bergantung pada konstruksi) dengan kontak-yang-diam. Ketika arus ke koil 

diputuskan, angker dikembalikan dengan paksa ke posisi awal, biasanya hal ini 

dilakukan oleh pegas, tetapi gaya gravitasi juga sering digunakan, umumnya pada 

starter motor industri. Pada umumnya relay diproduksi agar beroperasi dengan 

cepat. Pada aplikasi bertegangan rendah hal ini bertujuan untuk mengurangi 

kebisingan sedangkan pada aplikasi bertegangan tinggi untuk mengurangi 

terjadinya percikan api. 

http://www.sinauarduino.com/artikel/esp8266/
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Gambar 2.9 1. Kumparan tidak diberi arus 2. Kumparan diberi arus 

(Sumber: http://teknikelektronika.com//) 

 

2.8.1 Fungsi Relay 

 Fungsi relay, yaitu: 

1. Kontrol tegangan tinggi rangkaian dengan sinyal bertegangan rendah, 

seperti dalam beberapa jenis modem atau audio amplifier. 

2. Kontrol sebuah rangkaian arus tinggi dengan sinyal arus rendah, seperti 

pada selenoid starter pada sebuah mobil. 

3. Mendeteksi dan mengisolasi kesalahan pada jalur transmisi dan distribusi 

dengan membuka dan menutup pemutus rangkaian (perlindungan relay) 

4. Isolasi mengendalikan rangkaian dari sebuah rangkaian yang dikontrol 

ketika kedua rangkaian berada pada potensi yang berbeda, misalnya ketika 

mengendalikan sebuah perangkat bertenaga utama dari tegangan rendah 

switch. Yang akhir-akhir sering digunakan untuk mengontrol pencahayaan 

kantor sebagai kawat tegangan rendah dapat dengan mudah diinstal dan di 

partisi, yang dapat dipindahkan sesuai kebutuhan sering berubah. Mereka 

mungkin juga akan dikendalikan oleh hinian kamar detektor dalam upaya 

untuk menghemat energi listrik. 

5. Sebagai logika fungsi. Contohnya sebagai berikut, DAN fungsi boolean 

direalisasikan dengan menghubungkan relay normal ke kontak terbuka 

secara seri, maka fungsi ATAU dengan menghubungkan normal kontak 

terbuka secara paralel. Perubahan atas atau formulir C kontak melakukan 
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XOR fungsi. Fungsi yang sama untuk NAND dan NOR yang dicapai 

dengan menggunakan kontak normal tertutup. bahasa pemrograman 

tangga atau diagram ladder biasanya yang sering digunakan untuk 

merancang jaringan logika relay. 

6. Awal komputasi, sebelum tabung vakum dan transistor, relay digunakan 

sebagai unsur-unsur logis dalam dunia komputer digital. 

7. Safeti logika kritis. Karena relay jauh lebih tahan daripada semikonduktor 

radiasi nuklir, mereka banyak menggunakan relay dalam keselamatan 

logika kritis, seperti panel kontrol penanganan limbah radioaktif mesin. 

8. Waktu tunda fungsi, Relay dapat dimodifikasi untuk menunda pembukaan 

atau penutupan (sebuah proses) menunda satu set kontak yang sangat 

singkat (sepersekian detik) penundaan ini akan menggunakan tembaga 

disk antara angker dan bergerak blade perakitan. Arus yang mengalir 

dalam disk mempertahankan medan magnet untuk waktu yang sangat 

singkat, memperpanjang waktu rilis. Untuk sedikit lebih lama (sampai satu 

menit) keterlambatan, sebuah dashpot dapat digunakan. Sebuah dashpot 

adalah sebuah piston yang dapat diisi degnan cairan yang diperbolehkan 

untuk melarikan perlahanlahan. Jangka waktu dapat divariasikan dengan 

meningkatkan atau menurunkan laju aliran. Untuk jangka waktu lebih 

lama lagi, dapat mengiinstal mesin jam mekanik timer. 

 

2.9 Bahasa Pemrograman Arduino  

Arduino board merupakan perangkat yang berbasiskan mikrokontroler. 

Perangkat lunak (software) merupakan komponen yang membuat sebuah 

mikrokontroller dapat bekerja. Arduino board akan bekerja sesuai dengan perintah 

yang ada dalam perangkat lunak yang ditanamkan padanya.  

Bahasa Pemrograman Arduino adalah bahasa pemrograman utama yang 

digunakan untuk membuat program untuk arduino board. Bahasa pemrograman 

arduino menggunakan bahasa pemrograman C sebagai dasarnya.Karena 
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menggunakan bahasa pemrograman C sebagai dasarnya, bahasa pemrograman 

arduino memiliki banyak sekali kemiripan, walaupun beberapa hal telah berubah. 

 

2.10 Arduino Development Environment 

 Ardunio Development Environment terdiri dari editor teks untuk menulis 

kode, sebuah area pesan, sebuah konsol, sebuah toolbar dengan tombol-tombol 

untuk fungsi yang umum dan beberapa menu. Ardunio Development Environment 

terhubung ke arduino board untuk meng-upload program dan juga untuk 

berkomunikasi dengan arduino board. 

 Perangkat lunak yang ditulis menggunakan Ardunio Development 

Environment disebut sketch. Sketch ditulis pada editor teks. Sketch disimpan 

dengan file berektensi .ino. area pesan memberikan informasi dan pesan error 

ketika kita menyimpan atau membuka sketch. Konsol menampilkan output teks 

dari Ardunio Development Environment dan juga menampilkan pesan error ketika 

kita mengkompile sketch. Pada susut kanan bawah dari jendela Ardunio 

Development Environment menunjukkan jenis board dan port serial yang sedang 

digunakan. Tombol toolbar digunakan untuk mengecek dan mengupload sketch, 

membuat, membuka atau menyimpan sketch, dan menampilkan serial monitor. 
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Gambar 2.10 Arduino Development Environment 

(Sumber: http://www.wikiwand.com/en/Arduino) 

Berikut ini adalah tombol-tombol toolbar serta fungsinya: 

▪ Verify  

mengecek error pada code program.  

▪ Upload  

meng-compile dan meng-upload program ke Arduino board.  

▪ New  

membuat sketch baru. 

▪ Open 

menampilkan sebuah menu dari seluruh sketch yang berada di 

dalam sketchbook. 

▪ Save  

menyimpan sketch. 

▪ Serial Monitor  

membuka serial monitor.  
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Dalam lingkungan arduino digunakan sebuah konsep yang disebut 

sketchbook, yaitu tempat standar untuk menumpan program (sketch). Sketch yang 

ada pada sketchbook dapat dibuka dari menu File > Sketchbook atau dari tombol 

open pada toolbar. Ketika pertama kali menjalankan arduino development 

environment, sebuah direktori akan dibuat secara otomatis untuk tempat 

penyimpana sketchbook. Kita dapat melihat atau mengganti lokasi dari direktori 

tersebut dari menu File > Preferences.  

Serial monitor menampilkan data serial yang sedang dikirim dari arduino 

board. Untuk mengirim data ke board, masukkan teks dan klik tombol send atau 

tekan enter pada keyboard.  

Sebelum meng-upload program, kita perlu mensetting jenis board dan port 

serial yang sedang kita gunakan melalui menu Tools > Board dan Tools > Serial 

Port. Pemilihan board berguna untuk mengeset parameter (contohnya: kecepatan 

mikrokontroler dan baud rate) yang digunakan ketika meng-compile dan meng-

upload sketch.  

Setelah memilih board dan port serial yang tepat, tekan tombol upload 

pada toolbar atau pilih menu File > Upload. Arduino board akan me-reset secara 

otomatis dan proses upload akan dimulai. Pada kebanyakan board, LED RX dan 

TX akan berkedip ketika program sedang di-upload. Arduino development 

environment akan menampilkan pesan ketika proses upload telah selesai, atau 

menampilkan pesan error.  

Ketika sedang meng-upload program, arduino bootloader sedang 

digunakan, Arduinp bootloader adalah sebuah program kecil yang telah 

ditanamkan pada mikrokontroler yang berada pada arduino board. Bootloader ini 

mengijinkan kita meng-upload program tanpa menggunakan perangkat keras 

tambahan. 

 

2.11 Android 

 Android adalah sistem operasi yang berbasis Linux untuk telepon seluler 

seperti telepon pintar dan komputer tablet. Android menyediakan platform terbuka 



26 
 

  

bagi para pengembang untuk menciptakan aplikasi mereka sendiri untuk 

digunakan oleh bermacam peranti bergerak. Awalnya, Google Inc. membeli 

Android Inc., pendatang baru yang membuat peranti lunak untuk ponsel. 

Kemudian untuk mengembangkan Android, dibentuklah Open Handset Alliance, 

konsorsium dari 34 perusahaan peranti keras, peranti lunak, dan telekomunikasi, 

termasuk Google, HTC, Intel, Motorola, Qualcomm, TMobile, dan Nvidia.  

Pada saat perilisan perdana Android, 5 November 2007, Android bersama 

Open Handset Alliance menyatakan mendukung pengembangan standar terbuka 

pada perangkat seluler. Di lain pihak, Google merilis kode–kode Android di 

bawah lisensi Apache, sebuah lisensi perangkat lunak dan standar terbuka 

perangkat seluler.  

Di dunia ini terdapat dua jenis distributor sistem operasi Android. Pertama 

yang mendapat dukungan penuh dari Google atau Google Mail Services (GMS) 

dan kedua adalah yang benar–benar bebas distribusinya tanpa dukungan langsung 

Google atau dikenal sebagai Open Handset Distribution (OHD). 

 

2.11.1 Versi Android 

Android memiliki banyak versi semenjak dirilis pertama kali. Berikut ini 

merupakan versi–versi yang dimiliki Android (Safaat, 2012:10): 

1. Android versi 1.1 

2. Android versi 1.5 (Cupcake) 

3. Android versi 1.6 (Donut) 

4. Android versi 2.0/2.1 (Eclair) 

5. Android versi 2.2 (Froyo) 

6. Android versi 2.3 (Gingerbread) 

7. Android versi 3.0/3.1/3.2 (Honeycomb) 

8. Android versi 4.0 (Ice Cream Sandwich) 

9. Android versi 4.1/4.2/4.3 (Jelly Bean) 

10. Android versi 4.4 (Kitkat) 
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2.12 App Inventor 

App Inventor adalah aplikasi web sumber terbuka yang awalnya 

dikembangkan oleh Google, dan saat ini dikelola oleh Massachusetts Institute of 

Technology  (MIT).   App  Inventor    memungkinkan    pengguna    baru    untuk 

memprogram komputer untuk menciptakan aplikasi perangkat lunak bagi sistem 

operasi Android.  

App Inventor menggunakan antarmuka grafis, serupa dengan antarmuka 

pengguna pada Scratch dan StarLogo TNG, yang memungkinkan pengguna untuk 

men-drag-and-drop objek visual untuk menciptakan aplikasi yang bisa dijalankan 

pada perangkat Android. Dalam menciptakan App Inventor, Google telah 

melakukan riset yang berhubungan dengan komputasi edukasional dan 

menyelesaikan lingkungan pengembangan online Google. 

 

Gambar 2.11 App Inventor 

(Sumber : http://novitstudio.com/) 

 

2.13 Flowchart  

 Flowchart atau diagram alir merupakan sebuah diagram dengan simbol-

simbol grafis yang menyatakan aliran algoritma atau proses yang menampilkan 

langkah-langkah yang disimbolkan dalam bentuk kotak, berserta urutannya 

dengan menghubungkan masing-masing langkah tersebut menggunakan tanda 

panah. Diagram ini bisa memberi solusi selangkah demi selangkah untuk 

penyelesaian masalah yang ada di dalam proses atau algoritma tersebut. 

https://id.wikipedia.org/wiki/Sumber_terbuka
https://id.wikipedia.org/wiki/Google
https://id.wikipedia.org/wiki/Massachusetts_Institute_of_Technology
https://id.wikipedia.org/wiki/Massachusetts_Institute_of_Technology
https://id.wikipedia.org/wiki/Pemrograman_komputer
https://id.wikipedia.org/wiki/Aplikasi_perangkat_lunak
https://id.wikipedia.org/wiki/Sistem_operasi
https://id.wikipedia.org/wiki/Sistem_operasi
https://id.wikipedia.org/wiki/Android_(sistem_operasi)
https://id.wikipedia.org/wiki/Antarmuka_pengguna
https://id.wikipedia.org/wiki/Antarmuka_pengguna
https://id.wikipedia.org/wiki/Scratch_(bahasa_pemrograman)
https://id.wikipedia.org/w/index.php?title=StarLogo_TNG&action=edit&redlink=1
https://id.wikipedia.org/w/index.php?title=Drag-and-drop&action=edit&redlink=1
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 Dalam penulisan Flowchart dikenal dua model, yaitu flowchart system dan 

flowchart program. flowchart system adalah bagan yang memperlihatkan urutan 

procedure dan proses dari beberapa file di dalam media tertentu, sedangkan 

flowchart program adalah bagan yang memperlihatkan urutan dan hubungan 

proses dalam suatu program. 

Tabel 2.4 Simbol-simbol Flowchart Standar 

Simbol-simbol Keterangan 

Simbol dokumen  Menunjukkan dokumen input dan 

output baik untuk proses manual, 

mekanik atau computer 

Simbol kegiatan manual Menunjukkan pekerjaan manual 

Simbol simpanan offline 

 

File non-komputer yang diarsip urut 

angka (numerical) 

Simbol simpanan offline 

 

File non-komputer yang diarsip urut 

huruf (alphabetical) 

Simbol simpanan offline 

 

File non-komputer yang diarsip urut 

tanggal (cronological) 

Simbol kartu plong Menunjukkan input/output yang 

menggunakan kartu plong (punched 

card) 

Simbol proses  

 

Menunjukkan kegiatan proses dari 

operasi program komputer 

 N 

 A 

 C 
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Simbol operasi luar  

 

Menunjukkan operasi yang dilakukan 

di luar proses operasi komputer 

Simbol pengurutan offline Menunjukkan proses pengurutan data 

diluar proses komputer 

Simbol pita magnetic Menunjukkan input/output yang 

menggunakan pita magnetik 

Simbol hard disk Menunjukkan input/output 

menggunakan hard disk 

Simbol diskette Menunjukkan input/ouput 

menggunakan diskette 

Simbol drum magnetik 

 

 

Menunjukkan input/output 

menggunakan drum magnetik. 

Simbol pita kertas berlubang Menunjukkan input/output 

menggunakan pita kertas berlubang 

Simbol keyboard Menunjukkan input/ouput 

menggunakan keyboard 

Simbol display Menunjukkan  output yang 

ditampilkan di monitor 
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Simbol pitacontrol Menunjukkan penggunaan pita 

kontrol (control tape) dalam batch 

control total untuk  pencocokan di 

proses batch processing 

Simbol hubungan komunikasi Menunjukkan proses transmisi data 

melalui channel komunikasi 

Simbol garis alir Menunjukkan arus dari proses 

Simbol penjelasan Menunjukkan penjelasan dari suatu 

proses 

Simbol penghubung Menunjukkan penghubung ke 

halaman yang masih sama atau ke 

halaman lain 

 

 


